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General Information 

The UniVert is a precision test instrument designed for the compressive and tensile testing and 
analysis of materials including polymers, biological specimens, and 3D-printed constructs. The 
UniVert system includes a test station and an integrated software interface to run and analyze 
test results. 

Environmental and Electrical Specifications 

Electrical Input 100-240VAC, 50-60Hz 

Current Rating 2.71 Amp 

Environmental 
Conditions 

Maximum Operating Temperature 
25ºC 

0% - 95% Relative Humidity 

Installation Category Category II 

Pollution Degree Degree 2 

Data Connections 1 – USB for camera/PC 
communication 

(USB 3.0 for scientific camera) 

1 – USB for controller/PC 
communication 

System Assembly 

Some basic assembly and setup is required. An unboxing and setup guide can be found in 
Appendix A.  Load cell installation is detailed in Appendix B and software installation is 
described in Appendix C. Test setup and configurations are described in Appendix D. Camera 
setup is described in Appendix E. 

Connections to Supply 

Connect the power supply into a properly grounded 100-240VAC power source to ensure safe 
operation. Ensure that the power cord is easily accessible at all times. The use of an 
Uninterruptible Power Supply (UPS) is recommended to protect against data loss. 

The mains supply voltage fluctuations should not exceed 10% of the nominal supply voltage. 
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Safety Warnings 

This equipment must be used in accordance with the procedures outlined in this manual. 
Operators of this equipment must be instructed in safe operating procedures to prevent injury 
and/or damage. 

 
Ensure that the area around the moving actuator is clear before commencing test protocols. 

 

 

 

The UniVert presents a pinch hazard to extremities. Keep hands clear of moving parts for the 
duration of the test. 

 

Manual Operating Controls 

There are 2 manual switches on the front of the baseplate. The main power switch of the UniVert 
system is the leftmost switch (activating a green LED) and the Emergency stop switch (E-stop) is 
rightmost. The E-stop will stop power to the motor and instruct the software to stop a test if one 
has been executed. If the E-stop has been depressed, it must be rotated to return it back to its 
original position. 

The E-stop should only be used in emergency situations only since it will require a power cycle 
and actuator reset to set up a new test after it has been depressed (see Setting Up & Starting a 
Test: Step 8 for more details). 

General Maintenance 

Clean the system as needed with mild detergent and water or alcohol based cleaning solutions.  

Approvals and Certification 

This product conforms to applicable CE standards. 

 

System Alert 

This equipment must not be disassembled by the user or modified in any way except that 
which is described in this manual. 
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Testing Terminology 

The UniVert is designed to apply uniaxial compressive and tensile forces to a variety of materials. 
This includes soft metals, plastics, and composites as well as biological materials. 

Multiphase Test Cycles 

In order to properly characterize and test a specimen, it is often necessary to load it to different 
degrees and at different rates. There are three main reasons for doing this: 

Preconditioning - Especially for biological specimens, the goal of preconditioning is to restore a 
specimen to its physiological or in vivo state. During the process of specimen storage and 
preparation, a specimen may swell, dry out, have its material fibers realign, or its molecules 
reorganize. It may take multiple preconditioning cycles for a specimen to be restored to its natural 
state. 

 

Reproducing Physiological Conditions During Testing - By applying various loads and load 
rates, natural expansion and contraction of a specimen can be reproduced (for example, the 
pulse pressure in an organ). In as much as the physiological conditions can be recreated, the 
specimen can be tested in a more realistic state. 

 

Varying Test Conditions - Variable loads and rates allow you to create a variety of test profiles 
to best study your specimen. 
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Phases, Cycles, and Test Sequences 

As the following diagram demonstrates, each application and release of load on the specimen is 
called a test cycle. The same test cycle can be repeated multiple times to achieve a certain goal 
(preconditioning, physiological conditioning, or testing); this is called a test set. Finally, a test 
sequence is made up of multiple test sets.  

 

The above example describes the following: 

• The entire diagram presents a full test sequence.  

• Within that sequence, there are two test sets: the first set applies preconditioning to the 
specimen; the second set executes the actual test on the specimen.  

• Within the first set (preconditioning), two identical test cycles are implemented to bring 
the sample to a satisfactorily preconditioned state.  

• Finally, the second set (testing) is made up of three cycles.  
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Test Phases: The Smallest Unit of Testing 

The test phase is the smallest unit of the test specification. There are five phases within a cycle. 
Each phase serves a specific purpose:  

Preloading- Preloads are applied to bring a test to a well-
defined starting point. Because the dimensions of a 
specimen may change as a result of a loading cycle 
(stretching of fibers, viscoelastic effects, plastic 
deformation, or localized material failure at the attachment 
points), the preload adjustment compensates for any of 
these changes in specimen geometry.  

Stretching - During the stretch phase, a deformation is 
applied to the specimen. The deformation can be specified 
either in terms of force applied or displacement achieved. 
Note that in this context, the stretch phase refers to either 
stretching (for a tension test), or compression (for a 
compressive test). 

Holding - The deformation can be held for a given 
duration. The duration for which it is held is dependent on the nature of the testing. 

Recovering - The recovery phase is the time during which the force being applied to the 
specimen is removed. The duration of the recovery time is configurable and dependent on the 
nature of the testing. 

Resting - Finally, the rest phase is the time between the end of one cycle and the beginning of 
the next. Some tests may specify a short recover time or no recover time, while others may 
specify a longer time. The duration is configurable and dependent on the nature of the testing. 

Control Modes 

There are two control modes which define the basic approach to a given test: displacement 
control and force control: 

Under displacement control, the displacement of the specimen is predefined. The 
UniVert stretches or compresses the specimen until the predefined displacement is 
achieved (specified in mm or %). The force required to achieve the displacement is an 
output of the test. 

Under force control, the force applied to the specimen is predefined. The UniVert 
stretches or compresses the specimen until the predefined force is achieved (specified in 
newtons [N]).  The displacement required to achieve the force is an output of the test. 
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Control Functions 

The UniVert makes it possible to test specimens under several control functions: 

Under displacement control: 

The true strain function applies the displacement at a true strain rate, which accounts 
for the current specimen length while the specimen is being stretched and continuously 
recalculates the velocity.  The UniVert system approximates this with a series of linear 
segments. 

The ramp function applies the displacement at a constant nominal rate. This is 
equivalent to engineering strain or constant velocity.  

The sinusoid function applies the displacement according to a sinusoid with the desired 
displacement magnitude and duration. The UniVert system approximates this with a 
series of linear segments. 

 
Under force control: 

The ramp function applies the force at a constant nominal rate. This is equivalent to 
engineering strain or constant velocity. The result of this test will depend on the material 
being tested and the force control settings.   

The sinusoid function applies the force according to a sinusoid with the desired force 
magnitude and duration.  
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Test Modes and System Configurations 

There are three test modes that can be used when performing a test: tension, compression, and 
3-point bending. 

Tensile Test - This test mode is used in combination with provided specimen grips. In this mode, 
positive displacement is in the direction of increased fixture separation and tension forces are 
positive. 

Compression Test - This test mode is used in combination with provided compression platens. 
In this mode, positive displacement is in the direction of decreased fixture separation and 
compressive forces are positive. 

 

The UniVert can be used in two configurations: vertical and horizontal (see Appendix D for 
more details). The above test modes are all compatible in both configurations. For compression 
and 3-point bend testing, test samples will need to be supported to meet the height of the platens. 

 

  

 



UniVert User Manual 

8 

 

Software Overview 

The software included with the UniVert device is called UniVert.  It is divided into several 
modules: a data collection module and an image review and analysis module as well as test 
template review.  The data collection module is used to set test parameters, enable specimen 
loading and testing, and monitor test progress.  The screen layout for this module is shown 
below: 

 

The image review and analysis module is used to playback accelerated or decelerated test 
images, perform image analysis and tracking, and output movie files for presentation purposes.  
The screen layout for this module is shown below: 
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Output Files and Data Structures 

For each test, the UniVert creates and saves three file types. The following table describes the 
three file types for a project named “Sample1”. Output from this test would be found in a 
“Sample1” output directory (a sub directory of the user specified data directory). 

File Type Description 

.tst file The Sample1.tst file that contains the exact protocol and settings used for the 
test. 

.csv file The Sample1Data.csv file that contains comma separated numerical data such 
as time, force, and displacement values. 

.jpg files Captured images such as Sample1.000010.3.jpg, which would correspond to 
an image captured at 10.3 seconds from the start of the test. 

 

Each test folder will also contain 2-3 subfolders.  The “Logs” subfolder contains a text file of the 
content of the text dialogue portion of the main screen (in the lower left-hand side).  It is useful as 
reference to troubleshoot problems with your system, should they occur as well as track test 
progress. 

The “Tracking” subfolder is initially empty.  If tracking is done on any of the images in the test folder 
using the “Analyze and Review” software module, there will be data files that contain the tracking 
information stored in this directory.   

The “Images” subfolder usually contains any recorded .jpg images from a test.  These may also be 
stored in the main data folder. 

While using the “Analyze and Review” software module, you may create additional data files such 
as text files (*.csv) containing tracking results, images with force data or tracking results overlaid 
(*.wmf), or movie files (*.avi).  These additional files can be stored in the test directory or elsewhere 
on your computer’s main drive without interfering with the software application (once created, they 
must be opened by 3rd-party software). 

When working with the data, the user should be aware of a few details regarding the data output: 

1. The output specimen size is based on the spacing between the grips or platens and does 
not account for the specimen material outside of the test region. 

2. The software cannot calculate stress since the thickness of the specimen is not known. 
To calculate stress, you will have to manually measure the thickness of the material 
before or after the test is performed and apply this measurement to the output force data 

3. Strains can be calculated using the output displacement values (which are based on the 
grip or platen motions). The specimen may actually be subjected to less strain than the 
calculated values due to attachment site effects. The image tracking module is useful for 
determining the actual strain values and variations within the specimen. 
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Setting Up & Starting a Test 

Overview 

Step 1: Start a New Test 

Step 2: Reset the Actuator 

Step 3: Specify Test Type 

Step 4: Zero the Load Cell (occasional) 

Step 5: Modify the Test Parameters (optional) 

Step 6: Mount the Specimen 

Step 7: Execute the Test 

Step 8: Terminate the Test Prematurely (optional) 

Step 9: Saving the Template (optional) 

Step 10: End of Test Controls (optional) 

If this is your first time setting up the UniVert system, please complete the steps in Appendix A: 
Unpacking and Initial Setup prior to executing a test. 

Step 1: Start a New Test 

Launch the UniVert software and then select Collect New from the File menu.  
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In the Create Test From Template dialog, perform the following steps: 

1. Select a template that matches the type of test you wish to perform. See the below 
UniVert Tip on how to select and use a template. You can modify the template 
parameters in Step 5 below.  

2. Name your test. The dialog will have a default test name. You can use the default or 
rename the test. Each time you start a new test, the default name will continue to 
increment the number at the end of the name (a 3 digit number). 

3. If desired, you can change the location of the output data. The location of your output 
data and images is determined by specifying a Test Name and Data Directory. The 
template and data directories are user specific (computer login name). Each system user 
can store their files to a different default location. The system uses the last location 
selected as the default.  Note that a local drive should always be used and data 
transferred to network or cloud location after a test is complete. 

 

Step 2: Reset the Actuator  

We suggest performing a reset at the start of a new test session. This command sends the 
actuator to its fully retracted position and resets the displacement value.  If you have stopped the 
previous test in mid cycle, then you should also reset the actuator. By resetting the actuator, you 
are ensuring that the displacement measurements taken by the UniVert are accurate (dependent 
on an accurate Zero Position Calibration – see System Calibration and Advanced Tools).  

If you need to recalibrate the UniVert position, see the Zero Position Calibration or Custom 
Position Calibration portion in the System Calibration and Advanced Tools section. This is 
recommended if you are changing fixtures or configurations. 

To reset the actuator, select Reset Actuator from the Tools menu, or press  on the toolbar. 

 

 

 

  

UniVert Tip: Selecting and Using Templates 

How to create a Template: Designing an appropriate test sequence depends on both the type 
of material being tested and the specific material properties you are interested in measuring. 
When first testing a new material, you will have to experiment with the settings until the test 
yields meaningful data.  

The system comes loaded with sample templates to help you get started. Selecting a template 
does not lock you into a specific test sequence or protocol – rather a template preloads a test 
sequence and settings, all of which can be changed before a test is run.  

Once you have developed a test sequence with settings that are appropriate for the material 
you are testing, you should save these settings using “Save As Template” from the File menu. 
You can then select this template the next time you initiate a test. 

System Alert 

You should NOT reset the actuator if the specimen is already loaded in tension. Doing so will 
damage your specimen and/or the load cell. 
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Step 3: Specify Test Type 

Access Test Mode in the Settings menu to select the appropriate test mode and install the 
platens, grips, or 3-point bend attachments (see Appendix D for this procedure). 
 
 

 
 

Step 4: Zero the Load Cell (occasionally) 

While it is not necessary to zero the load cell with every test sequence, we suggest zeroing the 
load cell at the start of a new test session. With repeated use, the zero point of the load cell can 
drift. By zeroing the load cell, you are ensuring that the force measurements are accurate.  The 
force offset can also be affected by changing the fixtures. 

To zero the load cell, select Zero Load Cell from the Tools menu or press  on the toolbar. 

 

 

 

 

  

System Alert 

You should zero the load cell after attaching a platen or grip but before mounting a sample. If 
a specimen is already loaded when the load cell is zeroed, the force reading will include an 
offset load. 
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Step 5: Modify Testing Parameters (optional) 

 

You can select and modify the parameters in the test sets by clicking on a row in the Test 
Sequence table and then pressing the Edit Set button (or by double clicking on the desired row). 
When you do so, the Set Parameter Editor dialog will appear.  

 

Note that displacements are specified in either % strain, or mm. Force loads are specified in N, 
and durations are specified in seconds. 

 
The following table describes each of the parameters: 
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Test Parameter Description 

Control Mode Tests are performed under displacement or force control, however, you 
can select the following control modes to achieve specific testing 
objectives: 

• For creep testing, use force control with a long hold duration. 

• For stress relaxation testing, use displacement control with a 
long hold duration. 

Control Function True Strain, Ramp, or Sinusoid is typically selected for tests performed 
in displacement control mode. For tests performed in force control 
mode, Ramp or Sinusoid controls are selected.  

Stretch Magnitude  
(Load Magnitude 
when in Force 
Control mode) 

Selecting a stretch magnitude is dependent on the material you are 
testing. A sound approach is to begin with a small magnitude and 
iteratively move up to larger magnitudes.  

If you are using Displacement control mode, you can specify the 
displacement in either mm or as a percentage. For example, the 
displacement on a 5mm specimen can be expressed as either 0.5mm 
or 10%. 

If you are using Force control mode, you can only specify the force in 
N. 

Watch the test results carefully to determine which magnitude setting 
best achieves your test goals. 

Preload Preload is typically reapplied on every repetition during a 
preconditioning set as well as on the first repetition of a testing set. 
Specimen size is adjusted after a preload adjustment. Strain 
calculations are based on the specimen size after the last preload 
adjustment.  If you are working with a material for which preload values 
have been suggested, you can set the value accordingly. Otherwise, 
zero is a good initial choice.  The preload accuracy is directly influenced 
by the resolution/accuracy of the load cell you are using. 

Preload Magnitude As with stretch magnitude, the preload magnitude settings depend on 
the material you are testing. While Preload can be set at zero, typically 
you would set the preload magnitude somewhere between zero and 
10% of the peak load you expect to achieve. 

Stretch Duration For evenly spaced images, it is recommended to choose a number that 
is an integer multiple of the Image Output Frequency. 

Hold Duration Hold Duration is typically set to 0, however it is useful for creep or 
relaxation testing. 

Recovery Duration Recovery Duration is typically set to the same value as the Stretch 
Duration. 

Rest Duration Rest duration is typically set to 0, however a non-zero value may be 
used to mimic in vivo conditions or for specialized testing. 

Repetitions Apply enough repetitions until the force deformation curves from one 
repetition to the next start to overlie each other. 

Data Output 
Frequency 

Typically set to the same frequency as the image output frequency. 

Image Output 
Frequency 

Typically set to 1Hz for cycles > 5 seconds and 15 Hz for cycles < 5 
seconds. 
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Step 6: Mounting a Specimen 

Platen Mounted Specimens 

1. Install the compression platens (see Appendix D for more details) 
2. Place the specimen on the bottom platen.  
3. Jog the top platen to the correct position using the jog arrows in Actuator Control 

 

 

Alternatively, the Move Actuator to Specified Size  command may be used. Ensure the correct 

size value is entered before clicking .   
 

 
 

 

 

UniVert Tip: Compression Specimen Mounting 

Make sure to center the specimen on the platen as much as possible to ensure accuracy in 
the force reading. Ideally, specimens will have two parallel flat sides and will make full contact 
with both platens. Although this is not always possible, flat testing surfaces will improve force 
distribution. 
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Grip Mounted Specimens 

Low Force Grips 

1. Select a spring with an appropriate clamping force for the specimen being tested (see 
Appendix G for more details). 

2. Jog the actuator using Actuator Control until the grips are sufficiently far apart or enter the 

desired size and select Move to Specified Size . 

 

3. Attach the specimen to the top grip  

4. Using Actuator Control, lower the top grip (with specimen attached). 

5. Open the bottom grip and lower the specimen between the grip surfaces.  Release the 
bottom grip. 

 

 

 

 

  

UniVert Tip: Specimen Thickness 

Measuring the specimen thickness before and/or after a test is performed will allow stress 
calculations to be made from your output data. 
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High Force Grips 

1. Select a spring with an appropriate clamping force for the specimen being tested (see 
Appendix G for more details). 

2. Jog the actuator using Actuator Control or select Move to Specified Size  until the grips 
are sufficiently far apart.  

3. Loosen the M4 screw with a 2.5 mm hex key and squeeze the two halves of the top grip to 
clamp the sample. For higher clamping force, use the same hex key to tighten the locking 
screw against the back face of the grip. 

4. Using Actuator Control, lower the top grip (with specimen attached). 

5. Open the bottom grip and clamp the specimen between the grip faces. Use the 2.5 mm 
hex key to tighten the locking screw if higher clamping forces are required. 
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3-Point Bend Specimens 

1. Choose the appropriate 3-Point Bend dowel for the type of test you wish to perform. 
2. Install the 3-Point Bending test setup (See Appendix D) 
3. Move the sliders into desired position and lock in place by tightening the 4-40 fastener to 

the rail using a 3/32” hex key. 
4. Place the specimen on top of both lower dowels and begin testing. 

 

 
 
 

 
 
  

System Alert: Load Cell Handling 

It is important to handle load cells carefully. Here are some things to consider while handling a 
load cell: 

• The load cells are designed to handle overloads of up to 120% full scale value. 
Overloading a load cell past this rating may cause permanent damage to the 
load cell. 

• Avoid applying excessive torque and transverse forces to the load cells. Over 
tightening grips or platens onto the active end of the load cell may damage it. 

• Accidentally crashing the platens or grips together will produce more force than most 
load cells can handle. Be careful and reduce actuator speed when jogging grips or 
platens close together. 

• Generally, avoid dropping, tapping, and exerting unnecessary force to increase the 
life of the load cell 
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Step 7: Execute the Test 

Select Execute from the File menu or press  on the toolbar. 

Step 8: Terminate the Test Prematurely (optional) 

You can stop a test at any time by clicking  on the toolbar, or by selecting Stop from the File 
menu. These are preferred methods of ending a test instead of powering down the equipment or 
using the E-Stop, as it allows the software to store the current actuator position. 

At the end of the completed test (both normally and prematurely terminated) the actuators will 
maintain their current position.  

In an emergency, the Emergency Stop (E-Stop) button can be pressed to stop the motor from 

moving.  This button will stop power to the UniVert acutator and allow it to be moved by 
hand. The displacement position cannot be stored if the E-Stop has been depressed.  

 

Once the UniVert is ready to be used again, twist the E-Stop to return it to its original position. A 
new test cannot begin until the E-Stop has returned to its original position. The actuator will need 
to be reset to restore the position. To reset the actuator, select Reset Actuator from the Tools 

menu, or press  on the toolbar. An actuator reset is required before beginning a new test. 
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Step 9: Saving the Template (optional) 

At the end of the test (or before beginning the test), you may save the test parameters entered as 
a new template. Select Save as Template from the File menu. The Save Test as Template 
window will appear. Set a template name and click Save.  

 

By default, the new template will be stored in the current template directory. You may change the 
template directory at the start of a new test in the Create Test from Template window.  

 

 

 

If you would like to set a new template directory, create a new folder in your Windows File 
Explorer and set this file path as the new directory in the Create Test from Template window. You 
may delete templates through the File Explorer. Moving templates between directories will need 
to be done through the Windows File Explorer. 
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Step 10: End of Test Controls (optional) 

Once the test has been completed, you can choose to start a new test or use the system controls 
by selecting the “OK” button.  

 

 

System controls include the top ribbon as well as Actuator Control. These controls can be useful 
if you need to release a specimen from the text fixtures at the end of a test. 
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 Additional Settings 

Configuring Output Data Files 

From the Settings menu, select Data Output to display the dialogue shown on the left. Click the 
Configure button to select which of the following columns to output. 

  

 

Output Column Description 

Set Name  User defined name of each set 

Cycle Cycle and Phase information 

Time (S) Time point in seconds a data point was recorded 

Size (mm) Specimen Gauge Length at any given time 

Force (N) Load Cell reading 

Displacement (mm) Reports the change in size relative to the initial size 

Compensation (mm) Reports overall compensation due to system stiffness (see the System 
calibration and Advanced Tools section). Set to Off by default. 

Temperature (C) Temperature readings of the media bath from the probe (if applicable) 
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Advanced Settings 

Advanced Settings are available by selecting Advanced from the Settings menu. All these 
settings are specific to the test template selected. 

 

 

 

Show Warnings 

By selecting the check boxes, a warning dialogue will appear before either action button (i.e. 
Reset Actuators or Zero Load Cells). 

Resetting the actuators with a sample attached may damage the specimen, fixtures, and/or load 
cells.  To avoid resetting the actuators with a sample attached, a warning dialogue will appear 
after “Reset Actuators” is selected, prompting the user to proceed.   

System Stiffness Compensation 

System Stiffness Compensation can be used to compensate displacement readings that occur in 
the UniVert system during testing typically at high loads with low displacements.  Under most 
loading conditions these displacements are negligible and system stiffness compensation is not 
required.  

If you find this is necessary for your testing, check the enable button and see the System 
Stiffness Compensation section under System Calibration and Advanced Tools for more details 
and steps on how to complete the calibration procedure. 
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Motion Control Settings 

Motion Control Settings affect the rate and stability at which forces are achieved in force-
controlled procedures.  These settings apply to preloads as well as Force Control Modes. 

 

 

Max. Velocity (1-10 integer values) matches actuator jog speed. Typically for stiffer or smaller 
specimens (i.e. requires a short displacement to achieve desired force), use a lower velocity 
setting as this will allow for smoother force controlled protocols. It may take a few trials to 
optimize your test protocols and settings for your experiment. 

Velocity Jog Integer mm/s 

1 0.039063 

2 0.078125 

3 0.15625 

4 0.3125 

5 0.625 

6 1.25 

7 2.5 

8 5 

9 10 

10 20 
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Acceleration (1-10 integer values). Changes made to the acceleration will affect tests under both 
force and displacement control.  Reducing this value may help smooth force-controlled tests 
under low loads or displacement-controlled tests at high speeds.  Tests run with lower 
accelerations will have softer transitions at direction or speed changes but may take longer than 
specified to achieve specified testing cycles. 
 

Acceleration 
value 

m/s2 
Time (s) to 

achieve 20mm/s 
Travel (mm) to 

achieve 20mm/s 

1 0.004 5.0000 50.0000 

2 0.008 2.5000 25.0000 

3 0.016 1.2500 12.5000 

4 0.032 0.6250 6.2500 

5 0.064 0.3125 3.1250 

6 0.128 0.1563 1.5625 

7 0.256 0.0781 0.7813 

8 0.512 0.0391 0.3906 

9 1.024 0.0195 0.1953 

10 2.048 0.0098 0.0977 

  

Control Algorithm Settings Editing (Advanced) 

This setting offers the option to change from the programmed adaptive control algorithm to a 
custom algorithm. We recommend using the adaptive algorithm that has already been optimized 
for the BioTester5000, as improperly tuned PID settings may result in unstable behavior. We 
suggest only advanced users with specialized tests modify these PID settings. Contact CellScale 
for more information regarding these settings. 

 

  

UniVert Tip: Testing Force Control Settings 

It is important to have appropriate Force Control Settings that match the materials you are 
testing.   

To safely test Force Control Settings:  press  on 
the tool bar, or from the Tools menu select Move 
Actuators to Specified Load.  The dialogue shown on 
the right will appear.  The UniVert will attempt to 
achieve the specified load (force) but will stop when 
the specified load is reached, the actuator has 
displaced by the maximum specified amount, or the 
timeout time has elapsed. 

If the actuator oscillates around the specified loads 
but never achieves them try decreasing the velocity. 

 

If the actuator reaches the specified load too slowly, 
try increasing the velocity. 
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Range Limits 

Range limits can be accessed by selecting Range Limits from the Settings menu.   

 

 
 

Soft Range Limits 

To avoid collisions or sample destruction, it is useful to assign reasonable travel limits to the 
actuators. This is especially important during force control or preloading, where if specified loads 
cannot be reached, the actuators will keep moving until they reach the soft limits. 

• Min and Max Displacement, in mm, set the minimum and maximum positions to which 
the grips or platens can move.  These settings require adjustment especially when the 
fixtures are changed. 

• Max Force, in N, sets the maximum value of force at which a test will be automatically 
stopped.  The default value is set to the capacity of the load cells.  Setting this value may 
be useful to prevent sample destruction or overloading of the load cells. 
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Configuring the Live Charting Graphs 

The three graphs on the right side of the screen provide real-time user feedback during a test. 
These graphs are intended to be used for qualitative feedback, not for detailed analysis.  

The graphs are updated at a maximum frequency of 10Hz; certain short-duration tests may not 
show all the detail that is present.  

The graph settings can be specified by selecting Graphs from the Settings menu. Auto scaling 
allows the axis min and max to start at the specified values but expand if the data values are 
larger or smaller than the initial limits. 
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Graph Data 

Force versus Time 

This graph shows how the measured forces 
are changing with time. Peak loads per cycle 
and force relaxation are all easily seen in this 
type of graph. Force is proportional to 
nominal (engineering) stress. 

 

Displacement versus Time 

This graph shows how the grips or platens 
are moving with time. The phases of the test 
sequence and size adjustments due to 
preloading are readily apparent in this type of 
graph. 

 

Force versus Displacement 

This graph displays a qualitative 
representation of the material behavior. 
Viscoelastic effects (like hysteresis) and 
material response to different loading phases 
are apparent in this graph. This graph is 
proportional to a nominal (engineering) 
stress-strain graph. 
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Reviewing Test Results 

Overview 

The UniVert software has an integrated image analysis module which can be accessed by 
selecting Analyze and Review Images from the File menu, then selecting the appropriate test file.  
The test file is a text file with a .tst extension that contains information about the test parameters 
so that the software can display the images and data in a useful fashion. 

 

 

The basic UniVert system comes with a Logitech HD 1080p webcam intended to be used for 
recording images for image playback and review. This camera and software associated with it 
does not support image tracking. 

For image tracking to be available, the advanced scientific camera package must be purchased. 
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Selecting Images 

The Images are shown in a tree structure on the top left panel. 
The tree structure organizes the images by: 

Set (line on the test parameter window) 

Cycle (iteration of a given Set) 

Phase (Preload/Stretch/Hold/Recovery/Rest phase of each 
Cycle) 

Image (the one or more individual images from each Phase) 

You can select which images to include in a playback set in 
one of several ways: 

• Hold down the shift key and click on individual images 

• Select entire sets, cycles, or phases (will playback all 
contained images) 

• Select images which have data associated with a 
particular tracking set  

Image Playback Options 

The controls on the left of the screen are broken into 2 sections: 
Playback and Tracking.  

The playback buttons allow the user to review the images taken during 
a test. 

 

Next/Prev Display next or previous image (as dictated by “Play Every” parameter). 

Play/Stop Start and stop the playback. 

Prev/Next 
Cycle 

Jumps to a corresponding image and phase in the next or previous cycle. 
Useful when reviewing sets that have multiple cycles. 

Loop Sequences can be played continuously in a loop or only once. 

Playback 
Rate 

+/- changes the speed of the playback. A playback rate can also be manually 
entered in the display box. 

Play Every Allows the user to skip some frames to expedite playback. 
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Image Tracking: Overview 

Image tracking is a function that can be used to quantify the 
motions of image features (specimen texture and fiducial 
markers). This can be useful for studying localized specimen 
deformations, verifying strain magnitudes, and comparing the 
results of one test to another.  

The image tracking engine is based on a template matching 
algorithm. This algorithm starts by defining a “patch” of pixels 
(called a template) surrounding the selected source point on the 
source image. It then determines the optimal location for this 
template on a target image within a specified search region.  

 

The algorithm defines the location of the tracked point on the target image as the center of the 
optimally located template.  

To track an image, follow these steps: 

1. Click the Create button in the 
tracking window, shown above. 
This brings up the Tracking Editor 
dialogue box. 

 

2. Enter a Tracking Name. 

3. Select Source Image in the test 
image list tree and click Set to the 
right of the Source box. 

4. Select the Target Images in the 
test image list tree, and click Set 
to the right of the Target box. The 
target image list will automatically 
be sorted to remove duplicates 
and be put in sequential order. 

5. Generate source points on the 
source image by performing the 
following steps: 

a. Manually click source point 
locations on the source 
image with the Add button 
depressed. 
 

OR 
 

b. Draw a box on the source image with the Select button depressed, then click the 
Grid button and define a grid of points. 

 

The displayed image will automatically change to the source image when either the Add 
or Grid buttons are depressed. 
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6. Modify search parameters: 

Source 
Template 

The optimal source template is difficult to predict, but in general it is 
advantageous for the template to be large enough that it contains at 
least one feature, but not so large that it contains multiple features.  
Typical values for this parameter are between 15 and 55, with 35 
being a good starting point for most users.  Noticeable light/dark 
(grayscale) contrast is critical for the source template. 

Search Region The search region needs to be large enough that the optimal 
location for the template is found. In general, no part of the 
specimen moves more than the grips or platens, so the motion of 
these is a good guideline for how large the template needs to be.  
For example, if they move 50 pixels over the 10 frames you are 
interested in, it is unlikely that any part of the specimen is moving 
more than 5 pixels/frame and so a good value for the search region 
parameter would be 11 (5 pixels each way, plus the center pixel). 

Use Source 
Template From 

First Image tracks all images against the first in the series (1→2, 
1→3, 1→4…). 

Previous Image tracks each subsequent image against the image 
before it (1→2, 2→3, 3→4…). 

First Image Tracking tends to have poorer correlation than Previous 
Image Tracking because the current image is usually closer in 
content to the previous image than it is to the first image in the 
sequence. Previous Image Tracking tends to have good correlation 
for each individual step, but is prone to error accumulation since 
each step is independent. The best method for a given data set will 
depend on the number of images and the content of the images.  
Sometimes it is best to use Previous Image Tracking but to only 
use every other image or every nth image rather than all the images 
available. Sometimes it is best to use First Image Tracking and use 
every image but set the source image in the middle of the image 
series rather than at the beginning.   

Set Search 
Region Centre 

New Point Locations The location of the center of the search 
region is set to the same location of that point in the previous image 
(even when the source template is from the first image). 

Existing Point Locations The search region center location is set 
to the previously tracked location of that point. When no previously 
tracked point exists, the location is chosen in the same way as New 
Point Locations.  

Use Strain 
Based 
Deformable 
Templates 

When this option is checked, the source template will be scaled 
according to strains calculated from the Size parameters from the 
test data. In other words, the source template will be deformed 
according to the displacement of the grips or platens at that point in 
the test.  Best tracking results are often obtained when using this 
option. However, this option may not be the best for simple uniaxial 
tests or tests where the specimen deformation is non-uniform. 

7. Perform tracking with either Track All Points or Track Selected Points. 
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Image Tracking: The Points Display Option 

The Points option displays the points in their 
current location (i.e. their location on the currently 
displayed image) with or without gridline 
connecting points that were generated using the 
grid function.  

Clicking the Details icon brings up the window 
shown to the right. Options include changing the 
point radius or color, showing ID numbers, and 
showing gridlines with or without ID numbers.  

Gridline ID numbers are associated with each 
grid square (cell), while Point ID numbers are 
associated with the points themselves. 

Tracking display settings default to the last used 
settings. 

 

 

 

 

 

Figure 1: Initial tracking grid displayed as 
points. 

 

Figure 2: Tracking to 33% strain displayed as 
points. 
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Camera 

The UniVert software can be equipped with the standard webcam package, the scientific camera 
package, or no camera at all. The software will automatically detect which camera configuration is 
in use. 

Webcam Package 

The basic UniVert system comes with a Logitech HD 
1080p webcam intended to be used for recording 
images for image playback and review. This camera 
and software associated with it does not support 
image tracking. 

For image review purposes the webcam will capture 
images at up to 5 frames per second and obtain a 
resolution of 1900 pixels by 1080 pixels. Images 
captured by the webcam are written to a buffer. The 
test controller extracts images from this buffer at the 
specified frequency specified in the Set Parameter 
Editor (5Hz, 1Hz, 0.1Hz, 0.01Hz, or 0.001 Hz) These 
images are written to the output directory. The file 
name is the ideal capture time. The actual capture 
time may differ from the ideal capture time by as much 
as 1/30 of a second since the images are extracted 
from a buffer.  

 

 

The test software creates an image capture log file in the output directory should this difference 
be significant. This log stores the actual capture time and the idealized capture time. 

The webcam can be focused using the focus control in the Camera tab under Hardware in the 
Settings menu. The focal distance is set by entering a value between 0-100 (The higher the 
value, the smaller the focal distance). 

The shutter and gain control on the webcam are controlled automatically.  
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Scientific Camera Package 

The advanced scientific camera package is not included with the base UniVert system and is 
available as an added feature. This advanced option provides high quality images suitable for 
image tracking and the associated software is enabled with the image tracking feature (See the 
Reviewing Test Results: Image Tracking section above). 

The camera uses a 2/3” CMOS image sensor to obtain a resolution of 2048 pixels by 2048 
pixels. The camera shutter and gain can be controlled by accessing the Camera tab in 
Hardware Settings. 

The scientific camera captures images at 15 frames per second during every test and writes 
these images to a buffer. The test controller extracts images from this buffer at the frequency 
specified in the Set Parameter Editor (15Hz, 5Hz, 1Hz, 0.1Hz, 0.01Hz, or 0.001Hz). These 
images are written to the output directory. The file name is the ideal capture time. The actual 
capture time may differ from the ideal capture time by as much as 1/30 of a second since the 
images are extracted from a buffer. 

The test software creates an image capture log file in the output directory should this difference 
be significant. This log stores the actual capture time and the idealized capture time. 

The camera default shutter and gain are specific to each test template and can be set by 
selecting the Camera tab in Hardware from the Settings menu. The recommended maximum 
shutter speed is 10mS.  Typically, the camera iris is left fully open and the shutter and then the 
gain are adjusted to achieve the desired image brightness. 

Image Tracking: The Displacement Option 

The Displacement Option displays the points in their 
current location as well as graphically representing their 
motion through time.  

Clicking the Details icon brings up the window shown to 
the right. This dialogue allows the user to change the 
reference image, change the type of connecting line, 
and change the line appearance.  

Displacement connecting lines directly connect the 
reference and current points via a vector or a path. The 
path option provides more information but can result in 
slow playback speeds for sets with many points and/or 
many images.  

The Flow option generates a direction vector based at 
the current location and oriented in the direction of 
motion relative to the reference image. This can be 
useful because the length of this vector can be scaled 
to better visualize small displacements. 

Tracking displacement settings default to the last used 
settings. 
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Figure 3: Tracking to 33% strain displayed as displacement. 

 

Image Tracking: The Strains Option 

The Strains Option can only be used in conjunction with a grid 
of points (as opposed to individually placed points). This option 
calculates the regional strains inside every grid box and 
displays this data as an ellipse. One can imagine this is what 
would happen to a grid of circles drawn on the surface of the 
specimen at the beginning of the test. 

Clicking the details icon brings up the window shown to the 
right. This dialogue allows the user to change the reference 
image as well as the appearance of the circles and text.  

Showing text for E1, E2 will result in the text showing the 
principal strains along the major and minor axis of the ellipse. 
Showing text for Ex, Ey will result in text showing the strains 
along the X and Y directions regardless of the ellipse 
orientation. 

A 4-point or 16-point average can be used to calculate the 
strain inside each grid box (each individual grid box or each 
box plus additional surrounding grid points).  

Tracking strain settings default to the last used settings. 
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Figure 4: Tracking to 33% strain displayed as strain ellipses with text showing x% strain. 

 

 

Data Overlay 

Data associated with each image is displayed below 
the tracking controls on the left side of the main 
window.  Checking the Show Graph box displays this 
data as a graph overlaid on the images 

 

 

Clicking the details icon displays the window shown to 
the right. The dialogue allows the user to change the 
size and appearance of the overlaid graph. The data 
points associated with the current image are marked on 
the graph with green circles. The overlaid data graph 
will be drawn on top of any image tracking displays 
(when they overlap). 

Data Overlay settings default to the last used settings. 
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Figure 5: Tracking to 33% strain with overlaid force graph. 

 

Exporting Tracked Data 

Tracked grid point coordinates and calculated grid 
strains can be exported to a .csv file. From the Export 
menu, select Data Points to display the dialogue shown 
on the right. The image list is automatically set to the 
currently selected images in the test image list tree.  
This image list can be changed by selecting new 
images in the test image list tree and pressing the set 
button. When exporting strains data from Selected 
Tracking Points, all four points of a grid cell need to be 
selected for data from that cell to be exported. 

Exported data is labeled with associated ID numbers 
(grid point ID numbers for exported coordinates and 
grid cell ID numbers for exported strain values).  To 
display ID numbers on tracking grids, see Image 
Tracking: The Points Display Option.  In the following 
example (Figure 6), grid point ID numbers are shown in 
yellow and grid cell ID numbers are shown in white. 

The exported .csv file is written to the test directory.  

 

 

 

 

.  
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Figure 6: Tracking Grid showing ID Numbers  

 

 

Figure 7: Sample Exported Data. 
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Exporting Images and Movies 

The current Image view, including all displayed tracking 
grids, tracking data and overlaid data can be exported 
as a metafile by selecting Current Image from the 
Export menu.  Alternately, the current image view can 
be copied to the clipboard by pressing Ctrl-C on the 
keyboard. 

To export a series of image views, including all 
displayed tracking grids, tracking data and overlaid 
data as an .avi movie, select Movie from the Export 
menu.  The dialogue shown on the right will be 
displayed.  The image list is automatically set to the 
currently selected images in the test image list tree.  
This image list can be changed by selecting new 
images in the test image list tree and pressing the Set 
button.   Options are available for setting the frame rate 
or image size (resolution), adding filenames, and 
choosing color or grayscale output.  File compression 
options are also available. 
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System Hardware Settings 

Controller 

The UniVert uses an integrated control board rather 
than a group of PC controlled device drivers.  This 
minimizes communication lag and allows the device 
to operate asynchronously with the PC. The control 
board details can be seen by selecting Hardware 
from the Settings menu, which brings up the window 
shown to the right.  

 

 

 

 

Load Cell 

The load cells are semiconductor strain gauge based. 
They have accuracy equal to 0.2% of the rated full-
scale load. Load cells are available in 1N, 2.5N, 4.5N 
10N, 20N, 50N, 100N, and 200N sizes. Each load cell 
has a unique calibration factor which is stored in a 
chip contained in the load cell connector.  A 
calibration using test weights can also be carried out 
by the user. 

While the load cells should not have significant 
hysteresis or thermal drift, temperature changes or 
prolonged loading can introduce small offsets. It is 
recommended that the zero-load state be redefined 
before beginning a test. This can be done by selecting 
Zero Load Cells from the Tools menu or selecting 

 . 

The load cells are sampled at 100Hz, with hardware providing an 8-sample averaging to reduce 
noise in the data. Further sample averaging can be implemented by selecting Advanced from the 
Settings menu. 

Each load cell is calibrated and has a specific calibration factor which is stored on a chip in the 
load cell connector.  Field calibration using weights of known mass is recommended (see the 
System Calibration and Advanced Tools section of this manual).  The range and calibration 
factor can be viewed by selecting Hardware from the Settings menu but are not editable in this 
menu. 

Warning: Permanent load cell damage can occur if 120% of the full scale value is exceeded. 
Handle the load cell with care and make sure to select appropriate test protocols to avoid 
overloading.  
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Actuator and Motor 

The actuator is driven by a stepper motor under closed loop control. The motor moves a ball 
screw-driven carriage attached to the load cell and test fixtures. The actuator has a peak velocity 
of 20mm/s for the standard UniVert and 100mm/s for the UniVert S2 – High Performance. To 
prevent excessive velocities and accelerations, the control software will issue warnings if entries 
in the Set Parameter Editor result in accelerations or velocities that are out of range. Excessive 
thrust loads should only occur if mechanical interference obstructs the movement of the actuator. 
It is advisable to reset the actuators occasionally. The acceleration and velocity parameters can 
be modified in the Advanced Settings window if necessary for your materials or experiments (see 
the Advanced System Settings Dialogue section for more details). 

 

 

 

 

 

 

If the Emergency Stop (E-Stop) button has been depressed, power to the actuator will be cut. The 
motor carriage can be moved manually if necessary. However, the position of the motor will be 
compromised, and an actuator reset will be required before executing another test. 
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Heater 

To activate the fluid chamber heater, the unit must be 
powered on and the heater cable must be connected 
(the computer and software do not need to be on yet). 
At this point, the heater will warm the fluid to the last 
used temperature set point. The temperature set point 
can be changed by selecting Hardware from the 
Settings menu.  

Typically, the heater will take 30 to 60 minutes to 
warm a full fluid chamber from room temperature to 
37°C and will take up to 90 minutes to stabilize at this 
temperature.  To reduce this time, it is encouraged to 
use pre-heated media. 

When Show Temperature Warnings is enabled and the Current Temperature is not at the 
Temperature Set Point plus or minus the specified tolerance -- a red indicator button will be 
displayed next to the Current Temperature live output and a warning dialogue will appear when 
you execute the test. 

The Control Settings (PID) section displays the programmed settings for the temperature control 
of the heated bath. These have already been optimized for the UniVert heated bath. This section 
only displays the setting values (i.e. cannot be edited) to ensure the correct values have been 
programmed. 

 

System Alert 

In the event of a dislodged or faulty temperature sensor, or if there is a lack of fluid in the fluid 
chamber, the system is designed to reach a maximum temperature of less than 80°C. 

 

 

Caution: Avoid touching the chamber’s metal back panel when the heater is on, it can 
become very hot! 

 

 

  

UniVert Tip: Preheat Fluid 

You can add preheated fluid to the fluid chamber to reduce warm up time. 
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System Calibration and Advanced Tools 

Load Cell Calibration 

The load cells are preset with a calibration factor during manufacturing and quality check. 
However, calibration in the field is recommended. When the load cells are set up for the first time, 
changed, or moved it is advisable to perform a load cell calibration. This process will require a set 
of calibration weights (not included with system). Load cells can be calibrated attached to the 
UniVert system or with the Calibration Plates. 

Attached to System 

1. Attach the load cell to the fixed end of the UniVert (i.e. on the baseplate) with an M5x16 
SHCS and 4mm hex key. Ensure the measuring end of the load cell is facing away from 
the system (See Appendix B). 

 

 

 

2. Affix the calibration platen to the load cell. 
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3. Reset the actuator  to move the test fixtures out of the way. 

4. From the Tools menu select Load Cell Calibration 

 

 

 

5. Zero the load cell to remove the weight of the platen from the calibration values 
measured. 

6. Select the desired units to measure in. When using free weights this will always be in 
grams. 

7. Measure the zero-load condition for the first calibration point (no calibration weight) 

a. Enter “0” in the Enter Weight dialogue 

b. Click Read 
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8. Gently place a test weight onto the platen. This weight should be between 25%-90% of 
the load cell full scale value to ensure accurate calibration. Centre the weight on the load-
bearing surface to ensure in-line loads and use weights corresponding to the load cell 
capacity range. Do not overload the load cell. 

 

9. Take a measurement of the calibration test weight. 

c. Enter the weight in grams in the Enter Weight dialogue 

d. Click Read 

10. If desired, repeat steps 7 and 8 for multiple weights covering most of the load cell range.  
However, at least 2 weights within the load cell range is recommended. 
 

11. Click “Run”. 

12. Check the R Squared for reasonable values.  The R Squared is calculated based on a 
linear plot of the measured weights in the previous section. Ideally, this value should be 
as close to 1 as possible.  

13. Select which calibration factor to program to the load cell: 

a. Use Calculated Calibration will apply the new calculated value from the free 
weights applied in previous steps 

b. Use Factory Calibration will restore the factory calibration factor 

c. Continue with Current Calibration will keep the calibration factor that is currently 
programmed to the load cell. This could be the factory calibration factor if a new 
one has not been programmed. 

14. Click “Done” to close the window 

Note: Only take one reading per calibration weight used.  Multiple readings of a single load 
value can cause an error in the calibration algorithm  

Be sure to zero  the load cell again once the UniVert is in the desired testing 
configuration   
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Calibration Plates 

Alternatively, the load cells can be calibrated detached from the UniVert fixtures. 

1. Carefully remove the load cell being calibrated if it is attached to the UniVert fixtures. 
However, ensure the cable is still connected to the UniVert. 

 
2. Attach the two provided calibration plates to both ends of the load cell. 

 

 

3. Orient the setup such that the measuring end of the load cell is facing up and continue 
with the standard calibration procedure described above. 

 
 

 

 
Note: Calibration plates are only compatible with regular UniVert load cells. Low force load cells 
may only be calibrated while attached to the UniVert device. 
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System Alert: Load Cell Handling 

It is important to handle load cells carefully. Here are some things to consider while handling a 
load cell: 

• The load cells are designed to handle overloads of up to 120% full scale value. 
Overloading a load cell past this rating will cause permanent damage or failure. 

• Avoid applying torque and transverse forces to the load cells. Over tightening grips or 
platens onto the active end of the load cell may damage it. 

• Accidentally crashing the platens or grips together will produce more force than most 
load cells can handle. Be careful and reduce speed when jogging grips close 
together. 

Generally, avoid dropping, tapping and exerting unnecessary force to increase the life of the 
load cell. 
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Zero Position Calibration 

The actuator position is indicated in the Current Size dialogue on the left-hand side of the screen.  

 

This is the current separation of the edges of the clamps or platens.  For this measurement to 
have meaning, a zero position must be defined.  This is a position where the grip or platen tips 
would just touch each other.   

The Move to Size  command is also dependent on a correctly defined zero position. 

An actuator zero position is preset during manufacturing and quality check.  However, the zero 
position should be re-calibrated on initial system setup and whenever the grips, platens, load 
cells, or risers are changed.  Changing these components will always alter the zero position 
slightly. 

There is a software utility to automatically calibrate the zero position using a spring of known 
length provided with the UniVert system.  

The calibration spring is placed between the grips or platens.  The calibration utility slowly moves 
the grips or platens together until a small load is detected when contact with the spring occurs.  It 
then assigns this position as the size of the calibration spring being used. 
 
To calibrate the zero position, follow these steps: 
 

1. Open the Zero Position Calibration utility by selecting Zero Position Calibration in the 
Tools menu. 
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2. Place the provided calibration spring on the bottom platen or grip. For tests in 
horizontal configuration, place the UniVert in the vertical position to complete the zero 
position calibration. 

 

  

 

3. Zero the load cell using the Zero Load Cells button 
 

4. Specify the spring length (mm).  This figure is provided for each spring included in the 
UniVert system. 

 

5. Using the jog buttons, move the actuator such that there is a small gap between the 
top of the spring and the bottom of the upper platen or grip.  Do not contact the top of 
the spring.  Using a slow jog speed (below 5) is advisable for this reason. 

 
6. Select Run and let the calibration utility proceed. The software will calibrate the zero 

position automatically. 
 

7. Press OK to Reset Actuators and complete the calibration. 
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Custom Position Calibration 

Alternatively, the UniVert position can be defined with the use of digital or vernier calipers. 

To set a custom position: 

1. Jog the fixtures so their distance is within the reading range of the calipers 
2. Measure the distance between the fixtures with the calipers. Ensure the calipers are 

reading in millimeters.  
 

  

 

3. Open the Custom Position Calibration utility in the Tools menu 
 

 

 

4. Enter the distance read out by the calipers (in mm) and press Set to define a new custom 
position 
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System Stiffness Compensation 

System Stiffness Compensation can be used to compensate for the small displacements that 
occur in the system during testing due to flexion and load cell compression/tension. These 
displacements arise from any strains in the load cell and any bending or deformation of the 
system during loading. Under most loading conditions, these displacements are negligible and 
system stiffness compensation is not required.  System stiffness compensation plays a more 
significant role when testing stiff specimens that achieve high loads at low displacements.   

System Stiffness Compensation can be enabled or disabled under the Advanced Settings 
dialogue (Advanced from the Settings menu).  

 

When enabled, output displacement and size 
data in the .csv data output file will be modified.  
For example, in a test where a 10 mm specimen 
is being compressed by 1mm at 100N of force 
the system may be displacing by 0.1mm.  In this 
case when the actuators have moved 1 mm the 
specimen will only have been deformed by 0.9 
mm and the other 0.1 mm will have gone into 
deforming the load cell and system.  The output 
will show a displacement of 0.9 mm (rather than 
1.0) and a specimen size of 9.1 mm (rather than 
9 mm). 

 

Note: The system stiffness compensation does 
not affect or alter the applied loads or 
displacements only the reported values in the 
output .csv files. 

 

The amount of compensation being applied to 
the displacement and size columns of the output 
data file can also be shown as an additional 
output column (see the Additional Settings 
section). 

 

UniVert Tip: When to Apply System Stiffness Compensation 

Typically, System Stiffness Compensation will not be required.  It may be useful, however, 
when testing stiff specimens that achieve high loads at low displacements.  Most of the 
system deformation comes from the load cells which typically strain linearly by up to about 
200 µm at full scale load.  One can estimate the amount of system deformation by multiplying 
200 µm by the percent of load cell range that is used.  For example, when a load cell is at 
50% of its full-scale load (a 200N load cell at 100N, or a 10N load cell at 5N) the system 
deformation is estimated to be about 100 µm. To determine the effect of this displacement on 
your test you can divide this estimated system deformation by the maximum displacement in 
your test.   

For example, in a test with 10mm of displacement: 
100 𝑢𝑚

10 𝑚𝑚
=

0.1 𝑚𝑚

10 𝑚𝑚
= 1% 

We recommend using system stiffness compensation if the system deformation is more than 
10% of the applied deformation. 



UniVert User Manual 

54 

 

If system stiffness compensation is enabled, a calibration must be performed to determine the 
correct compensation factor.  This factor depends on the load cell being used and a new 
calibration must be completed each time the load cell is changed. There is a software utility to 
automatically perform this calibration. Before starting the software utility, attach the compression 
platens to the UniVert system. Also, place the Stiffness Compensation spacer that is provided (a 
small washer) onto the exact center of the lower platen.  

 

After placing the calibration spacer, slowly jog the platens together until there is a very small gap 
between the upper platen and the spacer. If this gap is too large, the software utility will take a 
very long time to run. However, do not allow the upper platen and the spacer to come in contact.  
If the platens crash together the load cell will likely be damaged.   

 

 

 

  

UniVert Tip: Jog Slowly to Protect Load Cells 

Jog the platens together at a slow speed to prevent crashing them together and damaging the 
load cell. Use lower jog speeds the closer the platens are to each other. 
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To perform system stiffness compensation calibration, follow these steps: 
 

1. Open the System Stiffness Compensation utility by selecting Advanced → System 
Compensation from the Tools menu.  

2. Zero the load cells.  
3. Use the jog buttons to decrease the gap above the spacer. Do not contact the top of the 

calibration spacer. 
4. Click Run to start the calibration and set the stiffness compensation value. 
5. Press OK to Reset Actuators and complete the calibration. 
6. The calculated system stiffness compensation value will be displayed in the message 

window. 
 

 

 

The calibration utility will slowly drive the platens together until the full-scale load is reached on 
the load cell.  Resulting load displacement data is typically very linear and a best-fit slope is used 
to determine the calibration factor.  Compensation is calculated in compression but is assumed to 
act linearly in both tension and compression. 
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Snap Image Feature 

Located under Tools>Snap Image. 

This feature allows the user to capture a single image during the setup phase.  This can be useful 
for documenting specimen loading activity and neutral (non-contact) beam position. 

 

Update Firmware 

Periodic firmware updates may be issued by CellScale for the UniVert. When a new firmware or 
software is available, you may download it from our website (www.cellscale.com/downloads).  

To update the firmware: 

1. Connect the UniVert to the PC via USB and turn on power to the UniVert 
2. Open the UpdateFirmware.exe program located in Univert>Software>Utilities>Update 

Firmware  
3. The program will automatically update the firmware of the UniVert 
4. Power cycle the system after the firmware is successfully updated before using the 

UniVert software again 
 

The firmware version is checked and the automatic updater is also run when installing a new 
version of the software. 

 

 
  

http://www.cellscale.com/downloads
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If the automatic firmware update software does not work, please follow the manual steps below: 

1. With the UniVert connected to the PC and turned on, launch the manual firmware update 
software located in UniVert>Utilities>Update Firmware>Advanced. 

2. Click the Connect button. 
3. Load the firmware file using the Browse button. The file will be a .bin extension. 
4. Execute the update using the Update button. 
5. Power cycle the system after the firmware is successfully updated before using the 

UniVert software again. 
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Troubleshooting 

Communication Errors: Read File or Write File 

When communication errors occur the live message window will display a ReadFile or WriteFile 
failed message. Communication errors can occur if: 

• The UniVert is not powered up. 

• USB cables between the computer and UniVert are disconnected. 

• The supply power surges or is interrupted.  

When a communication error occurs, close UniVert software, check connections, power cycle the 
UniVert Device, and restart the UniVert software.  Be sure to reset the actuators before setting up 
a new test. 

 

  

UniVert Tip: Preventing Power Disruptions 

We recommend plugging the UniVert (and host computer) into an uninterruptable power 
supply (UPS) or battery back-up. 
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Actuator Limits 

When changing between horizontal and vertical configurations, it is possible to reach the lower 
range limit of the actuator. Hitting the physical range limit may affect the accuracy of the Current 
Size reading. To avoid this, there are several software warnings which occur under these 
circumstances: 
 

Moving the actuator out of range with Move to Force :  
If the actuator is moved past the range limit when using Move to Force the UniVert software will 
display an error message (shown below). It is recommended to perform an actuator reset before 
continuing testing. You may need to adjust the range limits by selecting Range Limits in the 
Settings menu to accommodate your specimen.  
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Reaching the actuator limit during a test:  
If the actuator is moved past the range limit during a test, the UniVert software will terminate the 
test and display an error message: 
 

 
 

 

 
  

UniVert Tip: Zero Position Calibration 

Perform a zero position calibration (see the System Calibration and Advanced Tools 
section) when the load cell, grips, or risers are changed. A correct zero position will ensure 
that the failsafe features for the actuator limits (described above) will work as intended. 
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Emergency Stop  

 

If the Emergency Stop (E-Stop) has been depressed, a new test cannot begin until it has returned 
to the disengaged position. Twist the red E-Stop button on the UniVert controller in either 
direction and this will allow the switch to pop out again.  

 

 

 

This switch is intended to be used only in case of EMERGENCY as the actuator will lose its 
position when the E-Stop has been depressed. Once the E-Stop has been returned to its original 
position after the being activated, power cycle the UniVert and reset the actuators to restore the 
position accuracy. 

 

A test cannot begin until an actuator reset has been completed after the E-stop is returned to its 
original position. 
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Appendix A: Unpacking and Initial Setup 

The system components listed below may be unpacked and laid out before system setup. A 
clearance space (L x W x H) of 25cm x 35cm x 60cm and 60cm x 35cm x 25cm is required for 
vertical and horizontal configuration setup respectively. 

Tools 

Hex keys (2.5mm, 3mm, 4mm, and 5mm) 

Components 

Item Name Item Quantity 

UniVert Main Unit 

 

1 

Pivot Wings 

 

2 

Motor Bracket A 

 

1 

Motor Bracket B 

 

1 

Horizontal Bracket 

(No Load Cell) 

 

1 
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M5 Tension Load Cell 
Bracket 

 

1 

M3 Tension Load Cell 
Bracket 

 

1 

Load Cell 

 

1 

Calibration Plates 

 

2 

Light Grip Springs 

 

3 

Medium Grip Springs 

 

3 

Heavy Grip Springs 

 

3 

M3 Compression 
Platen (Plastic) 

 

1 
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M5 Compression 
Platen (Stainless Steel) 

 

1 

M5 Compression Base 
Riser - Tall 

 

1 

M5 Compression Base 
Riser – Short 

 

1 

M3 Specimen Grip 
(Plastic) 

 

1 

M5 Specimen Grips 
(Stainless Steel) 

 

2 

M5 Locking Discs 

 

2 

M3 Locking Discs 

 

2 
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M5 Coupling Nut 

 

1 

M5 to M3 Thumbnut 

 

1 

M5 Stand Off 

 

1 

Calibration Spring 

 

1 

Sample Test 
Specimens 

 

4 

Stiffness 
Compensation Spacer 

 

1 

Camera 

 

1 
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Tripod 

 

1 

24V Power Supply 

 

1 

USB Cable 

 

1 

Fasteners 

Size Purpose Quantity 

M4x12 SHCS Mount Pivot Wings to Main Unit 4 

M4x8 SHCS Attach Motor Bracket B to Motor Bracket A 4 

M5x12 SHCS 

 

Attach Horizontal Fixtures (M5) 

(see Appendix D for more details) 

Mount loadcell or fixtures to Motor Bracket B 

4 

M3x12 SHCS Attach Horizontal Fixtures (M3) 

(see Appendix D for more details) 

1 

M5x16 SHCS Mount fixtures to baseplate 1 

M4x25 FHCS To increase clamping force of M5 Specimen Grips 2 

 

 

SHCS 

(Socket Head Cap Screw) 

 

FHCS 

(Flat Head Cap Screw) 
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Step 1: Unpack the main unit and the accessories 

Set aside the main unit, Pivot Wings, 4 x M4x8 SHCS, Motor Bracket B, 4 x M4x8 SHCS, and 
3mm hex key 
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Step 2: Attach Motor Bracket B to Motor Bracket A 

Attach the Motor Bracket with 4 x M4x8 SHCS using the 3mm hex key 

 

 

Step 3: Attach the Pivot Wings to the main unit 

Attach both Pivot Wings to the side of the UniVert with 4 x M4x8 SHCS using a 3mm hex key 
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Step 4: Install the UniVert software 

See Appendix C: Software Installation for more information. 

 

Step 5: Attach the load cell 

See Appendix B: Load Cell Installation for this procedure. 

 

Step 6: Attach platens or grips to the load cell 

See Appendix D: Test Setup for this procedure 

 

Step 7: Connect all necessary cables to the UniVert 

A 24V brick power supply powers the UniVert system via a barrel connector on the back of the 
control box.  The UniVert control box is connected to the PC via a USB connection. 

The load cell connector has a keyway inside the connector and a locking ring to ensure proper 
connection. To connect a load cell, align the keyway, push the connector in, and turn the 
threaded locking ring until tight.  Note that this may require several turns to lock in place. 

The temperature probe and heater connectors also have a keyway. Align the red marks on both 
the panel connector and cable connector. These connectors will only be present if a Media Bath 
package is purchased with the UniVert (see Appendix F for more detail on how to set up the 
media bath). 

 

 

 

System Alert: Load Cell connector 

Only twist the silver threaded coupling when attaching and 
detaching the load cell connector. DO NOT twist the black 
rubber housing when the connector is mounted to the control 
box. This can damage the internal wiring and connectivity of 
the load cell.    

Load Cell 

Power 

USB 

Temperature 
probe and 

Heater 
(optional) 
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Step 8: Launch the software and begin a test to ensure the 
UniVert connects to the PC 

Run UniVert.exe and start a new test (File > Collect New). The software will output information on 
the initialization of the camera, load cell, and actuator. The software will output System Ready! 
when all systems have loaded and the UniVert is ready for testing. 

 

 

Step 9: Calibrate the Load Cell 

See the System Calibration and Advanced Tools section of this User’s Manual for more 
information. 

 

Step 10: Set the Actuator Zero Position 

See the System Calibration and Advanced Tools section of this User’s Manual for more 
information. 

 

Step 11: Begin Testing 

It is recommended that the User’s Manual be thoroughly reviewed before beginning testing using 
the UniVert system.  Procedures for loading samples, setting up tests, carrying out tests, and 
reviewing results are described in detail. 
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Appendix B: Load Cell Installation 

In order to avoid load cell damage, proper installation is required. Follow these steps when 
installing for the first time or changing load cells: 

1. Identify the active end of the load cell (see below image). This is the MEASURING END 
of the load cell which results in a force reading. This end is covered with a small plate not 
continuous with the rest of the load cell body. 

 

 

 

2. Attach the appropriate thumbnut/coupling to the NON-MEASURING END of the load cell 
(M5 or M3 depending on the load cell). 
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3. Attach the load cell and thumbnut/coupling assembly to the UniVert device: 
 

• For vertical configuration attach the load cell to Motor Bracket B with an M5x12 
SHCS using a 4mm hex key 

• For horizontal configuration, mount it to the baseplate of the UniVert with an 
M5x16 SHCS using a 4mm hex key.  

 

 

  

 

4. The measuring end of the load cell should be exposed, and the non-measuring end 
attached to the thumbnut/coupling and then to the UniVert. The test fixtures are ready to 
be mounted to the load cell.  
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Appendix C: Software Installation 

A Windows based PC (Windows 10 or above) with at least 1 USB ports is required to operate the 
UniVert (2 USB ports are required for the imaging feature).  Go to www.cellscale.com/downloads 
to download the latest UniVert software package. The package contains the software installer for 
the user interface and control software for the UniVert.   

To install the software: 

1. Go to the provided web address and download the compressed installation package.  
2. Transfer this file to the computer which will be running the UniVert device.   
3. Right click on the folder and select Extract All… to unzip.   
4. After this is complete, go to the uncompressed installation folder and select setup.exe.  

Details of typical dialogue boxes are shown below. 
 

 

http://www.cellscale.com/downloads
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Appendix D: Test Setup 

When using the UniVert in the vertical configuration, use the rightmost mounting hole on the 
baseplate for test fixtures. For the horizontal configuration, use the leftmost mounting hole on the 
baseplate for test fixtures.  

 

 

Tension Test Setup 

Set the test mode to Tension (Settings>Sign Convention>Pull +) in the software. This setting is 
specific to the test template being used and can be saved to a template. 

 

 
 

Horizontal 
Configuration 
Mounting Hole 

Vertical 
Configuration 
Mounting Hole 
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Vertical Configuration 

1. Install the desired load cell (see Appendix B) to Motor Bracket B. 
 

 

 

2. Screw a locking disc onto the measuring end of the load cell. Select either an M5 or M3 
locking disc based on the load cell. 
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3. Screw the appropriate grip onto the measuring end of the load cell after the locking disc.  
Tightening the locking disc against the grip allows the grip to be secured to the actuator 
at any rotational position. 

 
Finger tighten all components (ie. avoid using a wrench).  Beware of exerting excessive 
off-axis and torquing forces to avoid damage to the load cell. 

 
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

4. Attach the M5 stand off to the base with an M5x16 SHCS screw using a 4mm hex key. 
Use the mounting hole furthest from the power switch. This may be easier to do with the 
UniVert in the horizontal configuration. 
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5. Attached the M5 locking disc and grip to the stand off 
 

 

 

6. Attach the remaining grp to the M5 Stand Off and align the two grips until they are 
parallel. Loosen the locking discs to adjust the grips. Once they are aligned, hold the 
grips in place while tightening the locking discs. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7. A Zero Position Calibration is required after changing grips or platens.  See the System 
Calibration and Advanced Tools section of this manual for more details. 
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Horizontal Configuration 

 

Note the steps below outline the horizontal configuration that is required for the Horizontal Media 
Bath. If you do not have or want to use the Horizontal Media Bath for your test, you may use the 

vertical configuration set up with the UniVert tilted 90 on its side to use the device horizontally if 
this is more convenient for your test set up.   

 

 

1. Install the load cell (see Appendix B) to the fixed end of the UniVert with an M5x16 
SHCS using a 4mm hex key. Use the mounting hole closest to the power switch. Note 
that for the horizontal configuration, an additional locking disc should be added between 
the load cell and thumbnut.  
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2. Install the grip to the Tension Load Cell Bracket  

• For an M5 threaded load cell, use the stainless steel M5 grip, M5 Tension Load 
Cell bracket, M5x12 SHCS, 4mm hex key and M5 Locking Disc.  

• For an M3 threaded load cell, use the plastic M3 grip, M3 Tension Load Cell 
Bracket, M3x12 SHCS, 2.5mm hex key, and M3 Locking Disc. 

 

 

 

 
3. Install the Tension Load Cell Bracket to the load cell and affix it with the corresponding 

locking disc. The size of both these fixtures (M5 or M3) will depend on the load cell 
selected. 
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4. Attach the moving grip to the Horizontal Bracket (No Load Cell) with an M5x12 SHCS 

using a 4mm hex key. 
 
 

 
 

5. Attach the assembly from the previous step to the Motor Bracket B with 2 x M5x12 SHCS 
using a 4mm hex key. 

 

 
 

6. Align the grips until they are parallel by loosening the M5 screws and rotating the 
grip/assembly. When aligning the load cell/grip assembly, only handle the assembly by 
the body of the load cell. This is to prevent overloading or damaging the load cell. 
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7. A Zero Position Calibration is required after changing grips or platens. See the System 
Calibration and Advanced Tools section of this manual for more details. 

 

8. To prevent overloading and off-axis loading on the load cells, mount samples by pinch 
both the sides of the grip. Tilt the UniVert device away from you for more working room. 
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Compression Test Setup 

Set the test mode to compression (Settings>Sign Convention>Push +).  This setting is specific to 
the test template being used and can be saved to a template. 

 

 
 

Vertical Configuration 

1. Install the desired load cell (see Appendix B) to the Motor Bracket B of the UniVert 
 

2. Attach the compression platen directly to the measuring end of the load cell. Choose an 
M5 or M3 platen depending on the load cell. 

 
Finger tighten all components.  Beware of exerting excessive off-axis and torquing forces 
to avoid damage to the load cell. 
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3. Attach the M5 Compression Base Riser – Tall to the baseplate with an M5x16 SHCS 
using a 4mm hex key. Use the mounting hole furthest away from the power switch. This 
will be easier to do when the UniVert is lying in the Horizontal configuration. 
 

 

 

4. A Zero Position Calibration is required after changing grips or platens.  See the System 
Calibration and Advanced Tools section of this manual for more details. 
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Horizontal Configuration 

 

Note the steps below outline the horizontal configuration that is required for the Horizontal Media 
Bath. If you do not have or want to use the Horizontal Media Bath for your test, you may use the 

vertical configuration set up with the UniVert tilted 90 on its side to use the device horizontally if 
this is more convenient for your test set up.   

 

In addition, the test sample will need to be supported by a supplementary riser (not included with 
the UniVert) to use the compression test setup in the horizontal configuration. 

 

1. Install the compression platen to the Tension Load Cell Bracket  
a. For an M5 threaded load cell, use the stainless steel M5 platen, M5 Tension 

Load Cell bracket, M5x12 SHCS, 4mm hex key and M5 Locking Disc.  
b. For an M3 threaded load cell, use the plastic M3 platen, M3 Tension Load Cell 

Bracket, M3x12 SHCS, 2.5mm hex key, and M3 Locking Disc. 
 

   
 

2. Install the load cell assembly (see Appendix B) to the fixed end of the UniVert with an 
M5x16 SHCS and 4mm hex key. Use the mounting hole closest to the power switch.  
Note that for the horizontal configuration, an additional locking disc should be added 
between load cell and thumbnut. 
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3. Install the Tension Load Cell Bracket to the load cell and affix it with the corresponding 
locking disc. The size of both these fixtures (M5 or M3) will depend on the load cell 
selected. 
 

 

4. Attach the M5 Compression Base Riser – Short to the Horizontal Bracket (No Load Cell) 
with an M5x12 SHCS 

 

 

5. Attach the assembly from the previous step to the Motor Bracket B with 2 x M5x12 SHCS 
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6. A Zero Position Calibration is required after changing grips or platens.  See the System 
Calibration and Advanced Tools section of this manual for more details. 
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3-Point Bend Test Setup 

1. Set the test mode to compression (Settings>Sign Convention>Push +) 
2. Install the desired load cell for vertical configuration (see Appendix B) 
3. Attach a locking disc to the measuring end of the load cell. 

 

 

4. Assemble the 3-Point Bending Block and sliders: 

• Attach M2x6 fasteners on the sides of the sliders and bending blocks 

• Place 4-40 - 5/16” fasteners through the hole and the square nuts. Place the 
square nuts through the groove of the bottom block. 

• Use the large O-Rings and small O-Rings as illustrated below to hold the 3-point 
bending dowels in place (Note: Choose a dowel size appropriate for the test 
being performed. Small and Large dowels are provided with the 3-Point Bend 
package). 
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5. Screw the bending block onto the measuring end of the load cell and tighten it in the 
correct position using the locking disc. 

 

 

 
Finger tighten all components.  Beware of exerting excessive off-axis and torquing forces 
to avoid damage to the load cell. 
 

6. Attach and align the 3-Point bend rail onto the baseplate with 2x M5x25 SHCS. This may 
be easier to do with the UniVert in horizontal configuration and tilted back. 
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7. Secure both sliders on the rail in the desired position by tightening the fasteners with a 
3/32” hex key. 
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Appendix E: Camera Setup 

Webcam 

The webcam included with the UniVert system is used for recording images at up to 5Hz.  The 
UniVert will function with or without the camera plugged in. To setup the camera, follow these 
steps: 

1. Before starting the UniVert software, plug the webcam into a USB port. 
2. Thread the tripod into the mounting hole on the bottom of the camera. 

 

  

 
3. Set the camera in the desired recording position using the flexible tripod. 

 

 

 

4. Refer to the System Hardware Settings section for additional camera settings.  
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Scientific Camera  

The scientific camera, an optional add-on to the UniVert system, is used for recording images at 
up to 15Hz and is compatible with the image tracking feature in the UniVert software. First, set up 
the camera positioning system. The components and tools required are: 

• Rail 

• 2 x M6x6 SHCS 

• Rail Carrier 

• Mounting Post 

• Post Holder 

• Post Collar 

• 5mm hex key 
 

 
 

1. Place the UniVert in the horizontal configuration 
 

2. Install the camera rail with 2 x M6x6 SHCS using a 5mm hex key, in the desired location 
along UniVert tower  
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3. Thread the Post Holder to the Rail Carrier 

 

 

4. Slide the Rail Carrier onto the Rail and tighten the thumbnut at the back securely 
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5. Insert the Mounting Post in the Post holder. Ensure the M6 threaded hole is facing 
outward 

 

6. Attach the Post Collar to the Mounting Post. This is to ensure the post remains at the 
same height when adjusting the rotation with the Post Holder thumbnut 
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Next attach the camera assembly to the positioning system. The components and tools required 
are: 

• Camera  

• Camera Bracket 

• Lens 

• USB 3.0 cable 

• M3 SHCS 

• 2.5mm hex key 

• M6x6 SHCS 

• 5mm hex key 

• Ring light and power supply 

• Only for Camera Bracket shown below: 
o Mounting Plate 
o 4 x M2x6 SHCS 
o 1.5mm hex key 

 

 

1. Remove the lens caps from both the camera and lens, and gently thread the lens onto 
the camera. If the camera bracket provided matches the left one shown below, skip to 
Step 3. If the camera bracket provided matches the right one shown below, continue to 
Step 2. 
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2. Attach your bracket directly to the camera with 2x M3 SHCS and skip to Step 5: 
 

a. For use in the Vertical configuration, attach the camera as follows: 
 

 

 
b. For use in the Horizontal configuration, attach the camera as follows: 

 

 

 
3. Attach the Camera to the Mounting plate first with 2x M3: 

 
a. For use in the Vertical configuration, attach the camera as follows: 

 

 

b. For use in the Horizontal configuration, attach the camera as follows: 
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4. Attach the Camera Bracket onto the camera assembly with 4 x M2x6 SHCS using a 
1.5mm hex key 

 

 

5. Attach the Camera Bracket to the Mounting Post with M6x6 SHCS using a 5mm hex key. 
Both style of brackets mount to the Mounting Post in the same manner.  
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6. Attach the ring light to the lens by tightening the set screws and connect its provided 
power supply 

 

 

 
7. Attach the USB cable to the Camera, securing the USB locking screws, and plug the 

other end into a USB 3.0 (or higher) port on the PC. These are the typically labeled SS 
and/or have a blue plastic tab on the connector. 
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Lens Adjustments: 
 

1. The image brightness can be adjusted using the Iris Ring on the lens. It is recommended 
to leave the Iris Ring fully open and control image brightness with the Hardware Settings 
in the software (see the Reviewing Test Results section). 
 

2. Obtain desired magnification level by manually adjusting the W – T ring on the lens. 
 

3. Bring the image to optimum focus by manually adjusting the F – N ring on the lens. 
 

4. Use the set screws on each of the lens rings to lock them at the desired settings. 
 

 

 

  

Iris ring W – T ring F – N ring 
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Appendix F: Media Bath Setup 

The media bath allows specimens to remain submerged in a temperature-controlled fluid. 

Vertical Media Bath 

The components and tools required to set up the vertical media bath are: 

• Polycarbonate media chamber 

• Heater plate 

• Thumbnuts 

• Temperature probe 

• Heater cable 

• O-rings 

• Circular nylon spacer 

• M5x35mm SHCS 

• 4mm hex key 

• 2.5mm hex key 

• Long M5 to M3 coupling 

• Syringe 
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1. Attach the desired load cell to the Long Coupling Nut provided 
 

 

2. Attach the load cell assembly from the previous step to the Motor Bracket B on the 
UniVert with M5x12 SHCS and jog the moving end near its upper limit. This will allow for 
more room when installing the bath to the baseplate. 
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3. Fit a ½” O-ring supplied with the system into the groove in the bottom of the 
polycarbonate chamber. 

 

 
4. Attach the desired fixture and media chamber to the UniVert baseplate. Ensure the fixture 

is fastened tight and compresses the O-ring to ensure the chamber does not leak.  
a. For compression tests, align the compression platen over the polycarbonate 

chamber and fasten it to the baseplate with an M5x25 SHCS and 4mm hex key. 
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b. For tension tests, align the plastic spacer under the M5 Stand Off and fasten it to 
the baseplate with an M5x35 SHCS and 4mm hex key. Attach the locking disc 
and grip to the M5 Stand Off.  
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5. Place the UniVert motor housing back to its vertical position and place the heater plate in 
place. Make sure the O-ring on the back edge of the chamber is properly set and firmly 
fasten on the thumb screws. 

 

 

6. Attach the remaining grip or platen to the load cell 
 

 

 
7. Attach all connections for heater and temperature sensor 
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8. Secure the temperature sensor to the top of the chamber using an M4x8 Flat head 

fastener and the supplied D-clip 
 

 

 
 

9. To activate the fluid chamber heater, turn on the main power switch of the UniVert 
followed by the heater switch (if present on your device – see below). At this point, the 
heater will warm the media to the last used temperature set point. The temperature set 
point can be changed by selecting Hardware from the Settings menu. If the plate does 
not feel warm after a few minutes, ensure the heater plate cable is plugged in. 
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a. If your UniVert has 2 switches on the front panel, the second switch on the left 
(below the orange LED indicator light) is used to toggle the heater on/off if the 
cable is plugged in.  

 

 

 

b. If your UniVert only has 1 switch on the front panel (i.e., the main power switch), 
the heater will automatically turn on with the main power if it is plugged in. If you 
do not want the heater plate to be on during your test, leave the heater plate 
unplugged from the main device. 

 
10. Typically, the heater will take 30 to 60 minutes to warm a full fluid chamber from room 

temperature to 37°C and will take up to 90 minutes to stabilize at this temperature.  Using 
pre-heated media will help reduce the time needed to reach temperature. 

 
11. When Show Temperature Warnings is enabled and the Current Temperature is not at the 

Temperature Set Point (plus or minus the specified tolerance) - a red indicator button will 
be displayed next to the Current Temperature live output and a warning dialogue will 
appear when you execute the test. 

 

 

 

12. Once your test is complete, use the supplied syringe to remove the media from the 
chamber. Ensure the bath is completely empty before removing the back plate from the 
polycarbonate chamber. 
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Horizontal Media Bath 

The components and tools required to set up the horizontal media bath are: 

• Plastic Fluid Dish 

• Heater Plate 

• Heater Pivot Wings with sleeve bearings 

• 4x M4x16 SHCS 

• Shoulder screws 

• 3mm hex key 

• Temperature probe 

• Heater cable 

• Extra M5 or M3 Locking Discs 
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1. Attach the Heater Pivot Wings to the Heater plate with 4 x M4x16 SHCS using a 3mm 
hex key. 

 

 

 

2. Mount the Heater Plate and Heater Pivot Wings assembly to the UniVert system with the 
supplied shoulder screws and 3mm hex key. This will be easier to do with the UniVert in 
the vertical configuration. 

 

  

 

3. Place the UniVert back in its horizontal configuration. Be careful when doing so as the 
heater plate will swing freely. 
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4. Attach the additional locking disc between the desired load cell and corresponding 
coupling. 

 

 

 

5. Attach the desired fixtures to the load cell in the Horizontal Configuration (see Appendix 
D for more details). Tilt the UniVert back as this will allow for more room when fastening 
the fixtures. 
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6. Place the fluid dish on the Heater Plate and attach all the connections for the heater and 
temperature probe 
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7. Secure the temperature probe into the corner of the fluid dish 
 

 

8. To activate the fluid chamber heater, turn on the main power switch of the UniVert 
followed by the heater switch (if present on your device – see below). At this point, the 
heater will warm the media to the last used temperature set point. The temperature set 
point can be changed by selecting Hardware from the Settings menu. If the plate does 
not feel warm after a few minutes, ensure the heater plate cable is plugged in. 

 

 

  



UniVert User Manual 

116 

 

a. If your UniVert has 2 switches on the front panel, the second switch on the left 
(below the orange LED indicator light) is used to toggle the heater on/off if the 
cable is plugged in.  

 

 

 

b. If your UniVert only has 1 switch on the front panel (i.e., the main power switch), 
the heater will automatically turn on with the main power if it is plugged in. If you 
do not want the heater plate to be on during your test, leave the heater plate 
unplugged from the main device. 

 
9. Typically, the heater will take 30 to 60 minutes to warm a full fluid chamber from room 

temperature to 37°C and will take up to 90 minutes to stabilize at this temperature.  Using 
pre-heated media will help to reduce this time needed to reach temperature. 
 

10. When Show Temperature Warnings is enabled and the Current Temperature is not at the 
Temperature Set Point (plus or minus the specified tolerance) -- a red indicator button will 
be displayed next to the Current Temperature live output and a warning dialogue will 
appear when you execute the test 
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Appendix G: Grip Modifications 

The grips used for tension testing come in three different gripping strengths to suit different 
materials and tests. Replacement springs of varying stiffness are provided with the UniVert and 
these may be switched at any time using the jig provided. The light, medium and heavy springs 
will provide 10N, 20N, and 40N of gripping force, respectively.  

Changing Grip Springs 

Current Generation Grips 

1. Gather the required tools: 

• Grip 

• Desired spring 

• 3/32” hex key 

• 3mm hex key 

• Flat heat screwdriver 

• Safety glasses (recommended) 
 

2. Remove the M4 locking screw with the 3mm hex key 
 

 

3. Push down on the front of the grip and lock the spring in back notch using the flat head 
screwdriver 

 

Back 
Notch 
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4. Remove the dowel screws on either side with the 3/32” hex key, and remove the top 
piece of the grip 

 

 

5. Gently push down on the top spring arm to release it from the back notch 
 

 

6. Tilt the grip to the side to remove the dowel and spring 
 

7. Position the desired spring in the center of the grip and place the dowel back in place 
 

 

8. Push the spring arm down and lock it into the back notch 
 

9. Place the top piece of the grip over top and use the 3/32” hex key to fasten the dowel 
screws on either side 

 
 

10. Push down on the top of the grip to release of the spring arm from the back notch. Use a 
flat head screwdriver if necessary 
 

11. Use the 3mm hex key to place the M4 locking screw back in place 
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Previous Generation Grips 

1. Gather the required tools: 

• Grip jig 

• Screwdriver 

• Grip 

• Safety glasses (recommended) 
 

 

2. To remove the current spring, press both halves of the grip and place it inside the 
provided jig to keep the grip slightly open. 
 

 

  



UniVert User Manual 

120 

 

3. Use a screwdriver to push the dowel out of the grip. 
 

 

 

4. Carefully take the grip halves and spring out of the jig. It may be easier to use two hands 
for this step. Use one hand to squeeze the grip and the other to palm over the assembly 
to contain all the parts as it is removed from the jig. 
 

System Alert 

A fully installed spring experiences a high amount of stored energy. When removing the 
grip and spring from the jig, be sure to maintain pressure on both halves of the grip. 
Safety glasses are recommended when changing grip springs. 

 

5. Remove the dowel from inside the jig 
6. Place the desired spring into the groove in the top half of the grip. 
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7. Align the clamping face of the bottom half of the grip to the top and carefully press it 
down to compress the spring. 

 

   

 

8. Place the grip and new spring into the jig. Again, using two hands may make this step 
easier. Use one hand to maintain pressure on the spring, and the other to palm over the 
assembly to keep all components together. 
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9. Press the dowel into the grip 

  

 
10. Remove the grip from the jig by pinching the grip while pulling up 

 

 

Changing Jaw Coverings 

The current generation grips have jaw coverings available in a soft silicone or hard plastic with 
sandpaper.  The coverings are easily interchangeable by sliding the coverings on and off the grip 
jaws while the grip is open.  These coverings are optional and are best used if they provide a 
stronger grip on the test sample.   

 

UniVert Tip: High Force Grips 

Tighten the M4 locking screw on the high force grips (stainless steel) with a 2.5mm hex key to 
increase clamping force if the heavy springs are not enough. Do not use excessive force 
when tightening the screw. Overtightening could strip the screw hex head or damage the 
specimen. 
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Appendix H: Low Force Load Cells 

Low force load cells are an optional add-on to the UniVert system. They are available in 1N, 2.5N, 
and 4.5N capacities. These load cells have M3 female threads and will require a special set of 
fixtures. Components and tools required to use a low force load cell include: 

• Low force grips (M3 male thread and M5 female thread) 

• Light springs 

• Medium springs (assembled in grips) 

• Heavy springs 

• Low force compression platen (M3 male thread) 

• Plastic M3 Tension Load Cell Bracket 

• M5 to M3 stand off (long) 

• M5 to M3 stand off (short) 

• M3 Coupling nut 

• 2x M3x8 SHCS 

• 2.5mm hex key 
 

 

 

All test fixtures should be mounted to the measuring end of the load cells. The active measuring 
end of the low force load cells are shown below.  

      

 

Due to their low capacity and sensitivity, be careful when handling these load cells. Only 
handle the load cell by their sides and only use the low force fixtures to avoid overloading the 
load cells. 

Active End 

(Marked with F or  the 
side along black logo) 
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Tension Test Setup 

The low force grips are required to be used with the low force load cells. Replacement springs of 
varying stiffness are provided with the low force grips. The light, medium and heavy springs will 
provide 12N, 24N, and 60N of gripping force, respectively. 

 

1. Set the test mode to Tension (Settings>Test Mode>Tension). This setting is specific to 
the test template being used and can be saved to a template. 

 

 
 

2. Attach the M5 to M3 stand off to the non-measuring end of the low force load cell. 

• For vertical configuration, use the longer stand off 

• For horizontal configuration, use the shorter stand off 
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Vertical Configuration 

1. Attach the load cell assembly to the Motor Bracket B with an M5x12 SHCS using a 4mm 
hex key 

 

 

 

2. Ensure the measuring end of the load cell is exposed and attach the M3 (male thread) 
grip directly to the measuring end of the load cell.  

 

 

 
Finger tighten all components.  Beware of exerting excessive off-axis and torquing forces 
to avoid damage to the load cell. 
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3. Attach the M5 stand off to the baseplate of the UniVert with an M5x16 SHCS using 4mm 
hex key. This may be easier to do with the UniVert in the horizontal configuration. 
 

4. Attach the M5 locking disc and M5 grip to the M5 stand off. 
 

 

 

5. Align the grips to be parallel by loosening the M5 screw/locking disc and rotating the load 
cell assembly/grip. Only handle the load cell assembly by the coupling or the sides of the 
loadcell. Twisting the grip while it is attached to the load cell can result in overloading. 

 

 

 

6. A Zero Position Calibration is required after changing grips or platens.  See the System 
Calibration and Advanced Tools section of this manual for more details. 
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UniVert Tip: Mounting Low Force Load Cells to the Fixed End - Tension 

At velocities 3mm/s and slower, the UniVert uses smoother displacement commands to 
minimize vibrations induced from the actuator and fixtures. However, these commands cannot 
be used for velocities 3mm/s and faster since the desired velocities would be unachievable. 
The induced vibrations are generally negligible; however, due to the high sensitivity of low 
force load cells some of these vibrations can still be noticeable and may impact your test 
results. 
 
If any test protocol lines in your template exceed 3mm/s or your force readings are not smooth, 
we suggest mounting the low force load cell assembly to the fixed end of the UniVert for 
Vertical configurations.  
 
To set up your Low Force Load Cell on the fixed end, simply take your load cell assembly and 
mount it to the base place with an M5x16 SHCS and 4mm hex key. Attach the remaining grip 
assembly to the moving end with an M5x12 SHCS and 4mm hex key. 
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Horizontal Configuration 

 

Note the steps below outline the horizontal configuration that is required for the Horizontal Media 
Bath. If you do not have or want to use the Horizontal Media Bath for your test, you may use the 

vertical configuration set up with the UniVert tilted 90 on its side to use the device horizontally if 
this is more convenient for your test set up.   

 

1. Attach the grip to the M3 coupling nut and affix it to the Plastic M3 Tension Load Cell 
Bracket with an M3x8 SHCS using 2.5mm hex key.  

 

  

 

2. Attach the load cell to the above assembly with an M3x8 SHCS using a 2.5mm hex key 
 

Finger tighten all components.  Beware of exerting excessive off-axis and torquing forces 
to avoid damage to the load cell. 

3. Attach the load cell assembly to the baseplate with an M5x16 SHCS using a 4mm hex 
key 
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4. Attach a M5 locking disc to the M5 stand off and attach the M5 low force grip to this 
assembly 
 

 

5. Attach the assembly from the previous step to the Horizontal Bracket (No Load Cell) with 
an M5x12 SHCS and 4mm hex key 

6. Mount the assembly from the previous step to Motor Bracket B with 2 M5x12 SHCS and 
a 4mm hex key. 

 

 

 

7. Align the grips to be parallel: 

• For the fixed end (i.e. side with load cell), loosen the M5 screw in the baseplate 
to rotate the load cell assembly. 

• For the moving end, loosen the M5 locking disc and rotate the grip. 
 

8. A Zero Position Calibration is required after changing grips or platens.  See the System 
Calibration and Advanced Tools section of this manual for more details 
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Changing Grip Springs 

The grips come with three different gripping strengths to suit different materials and tests. The 
light, medium and heavy springs will provide 12N, 24N, and 60N of gripping force, respectively.  

 

To change a grip spring follow these steps: 

1. Gather the required tools: 

• 2.5 mm hex key 

• Grip 

• Spring 

• Calibration Plate 

• Safety glasses (recommended) 

• Small mallet and small screwdriver (optional) 
 

 

 

2. To remove the current spring, hold the grip with the pivot hole and dowel over top the M5 
hole of the Compression Plate. 
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3. Use the 2.5mm hex key to push the dowel out. Alternatively, a small mallet and/or a small 
screwdriver can be used instead or to assist in this step. 

 

  

 

4. Carefully separate the grip halves and remove spring out. The hex key or screwdriver will 
have likely taken the place of the dowel in the pivot hold of the grip. Carefully hold the 
grip with one hand while removing the hex key or screwdriver. 

 

 

 

System Alert 

A fully installed spring experiences a high amount of stored energy.   When removing 
the spring from the grip, be sure to maintain pressure on both halves of the grip. Safety 
glasses are recommended when changing grip springs. 

 

5. Remove the dowel from inside the Compression Platen. 
 

6. Place the desired spring into the cutout of the bottom half of the grip. 
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7. Align the clamping face of the top half of the grip to the bottom and carefully press it 
down to compress the spring.  

 

 

 

8. Ensure the pivot hole of the grip halves are aligned and press the dowel into the grip. If 
needed, gently tap the dowel against the surface of the table or with a small mallet while 
holding the grip securely. 
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Compression Test Setup 

The low force compression platen is required to be used with the low force load cells. Note the 
test sample will need to be supported by a supplementary riser (not included with the UniVert) to 
use the compression test setup in the horizontal configuration. 

 

1. Set the test mode to compression (Settings>Test Mode>Compression).  This setting is 
specific to the test template being used and can be saved to a template. 

 

 
 
 

1. Attach the M5 to M3 stand off to the non-measuring end of the low force load cell. 

• For vertical configuration, use the longer stand off 

• For horizontal configuration, use the shorter stand off 
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Vertical Configuration 

1. Attach the load cell assembly to the Motor Bracket B with an M5x12 SHCS using a 4mm 
hex key 

 

 

 

2. Ensure the measuring end of the load cell is exposed and attach the Low Force 
compression platen directly to the load cell 

 

 

Finger tighten all components.  Beware of exerting excessive off-axis and torquing forces 
to avoid damage to the load cell. 
 

3. Attach the M5 Compression Base Riser – Tall to the baseplate of the UniVert with an 
M5x16 SHCS using 4mm hex key. This may be easier to do with the UniVert in horizontal 
configuration. 

 

4. A Zero Position Calibration is required after changing grips or platens.  See the System 
Calibration and Advanced Tools section of this manual for more details. 
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UniVert Tip: Mounting Low Force Load Cells to the Fixed End - Compression 

At velocities 3mm/s and slower, the UniVert uses smoother displacement commands to 
minimize vibrations induced from the actuator and fixtures. However, these commands cannot 
be used for velocities 3mm/s and faster since the desired velocities would be unachievable. 
The induced vibrations are generally negligible; however, due to the high sensitivity of low 
force load cells some of these vibrations can still be noticeable and may impact your test 
results. 
 
If any test protocol lines in your template exceed 3mm/s or your force readings are not smooth, 
we suggest mounting the low force load cell assembly to the fixed end of the UniVert for 
Vertical configurations.  
 
Important Note: In compression test mode, the weight of your sample should not exceed the 
capacity of your load cell since it will be resting on the load cell throughout the entire test. 
 
To set up your Low Force Load Cell on the fixed end, simply take your load cell assembly and 
mount it to the base place with an M5x16 SHCS and 4mm hex key. Attach the remaining 
compression platen to the moving end with and M5x12 SHCS and 4mm hex key. 
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Horizontal Configuration 

 

Note the steps below outline the horizontal configuration that is required for the Horizontal Media 
Bath. If you do not have or want to use the Horizontal Media Bath for your test, you may use the 

vertical configuration set up with the UniVert tilted 90 on its side to use the device horizontally if 
this is more convenient for your test set up.   

 

In addition, the test sample will need to be supported by a supplementary riser (not included with 
the UniVert) to use the compression test setup in the horizontal configuration. 

 

1. Attach the Low Force Compression Platen to the M3 coupling nut and affix it to the 
Plastic M3 Tension Load Cell Bracket with an M3x8 SHCS and 2.5mm hex key 

 

 

2. Attach the load cell to the above assembly with an M3x8 SHCS and 2.5mm hex key 
 

Finger tighten all components.  Beware of exerting excessive off-axis and torquing forces 
to avoid damage to the load cell. 

3. Attach the load cell assembly to the baseplate with an M5x16 SHCS using a 4mm hex 
key 
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4. Attach the M5 Compression Base Riser – Short to the M5 stand off 
5. Attach the above assembly to the Horizontal Bracket (No Load Cell) with an M5x12 

SHCS and 4 mm hex key 
 

6. Mount the above assembly to the Motor Bracket B with 2 x M5x12 SHCS using a 4mm 
hex key. 

 

 

 

7. A Zero Position Calibration is required after changing grips or platens.  See the System 
Calibration and Advanced Tools section of this manual for more details. 
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Appendix I: BioRake Brackets 

 

BioRake and BioRake Brackets are an optional add-on to the UniVert. The tools and components 
required to use the BioRakes with the UniVert include: 
 

• BioRakes 

• BioRake Bracket - Load cell 

• BioRake Bracket - No Load cell 
 

 
 

1. Set up the desired load cell as per Appendix B for standard load cells or Appendix H for 
Low Force load cells. 
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2. Attach the BioRake Bracket – Load Cell to the load cell: 

• For standard load cells, use a locking disc to fasten the bracket. 
 

 

• For low force load cells, use a M3x8 SHCS and 2.5mm hex key to fasten the 
bracket. 

 

3. Attach the BioRake Bracket – No Load Cell to the Horizontal Bracket – No Load Cell with 
a M5x12 SHCS and 4mm hex key. 

 

 

4. Open the software and select Collect New. 
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5. Set the test mode to Tension (Settings>Test Mode>Tension). This setting is specific to 
the test template being used and can be saved to a template. 

 

 
 

6. Place the BioRakes on the brackets and use the jog command to bring the BioRake tips 
close together. 

 

 

7. Loosen and re-tighten the M5 fasteners or M5 locking disc to align the BioRakes such 
that they are horizontally aligned (i.e. parallel when looking from above) and vertically 
aligned (i.e. parallel when looking from the side)   
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8. To set the zero position: 

• Set one of the BioRakes slightly offset from the other 

• Jog the BioRakes closer together until the rakes are just intertwined 
 

 

• Open the Custom Position Calibration in the Tools menu 

• Set this position as 0 mm in the Custom Position Calibration menu 
 

 

 

9. The BioRakes are now ready to use with the UniVert. 
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